The Studio Midi WorkShop Latest Release Info
Thank you for purchasing the SAWStudio Midi WorkShop Add-In. This file contains the latest
enhancements and bug fixes.
The Midi WorkShop is automatically detected by SAWStudio and does not require you to patch it in
as a processing plugin. You can access its main window from the SAWStudio Views menu, or from
the popup Track List by Left-Clicking the up/dn arrow zone in the top left corner of the SAWStudio
MultiTrack. I highly recommend setting the SAWStudio Timeline to Tempo mode while using the Midi
WorkShop program. The main position readout remains in the SAWStudio MultiTrack and should
always be left at the top of the screen for reference.
To effectively use the interface, I recommend a minimum screen resoultion of 1280 x 1024 and
setting up your F-Key Workspace Views so no overlapping windows exist.
Please read the helpfile for setup and operation details.
Have Fun.
>---<

Version 2.0 Enhancements And Bug Fixes
Enhancements
* All window views are now "Border Padding" aware for better Win 7, 8 and 10 compatibility.
*

The MultiTrack Window will now accept DragnDrop operations of single midi file data from vsti
synth plugins. First select the hot track and cursor position, then drag and drop the data from the
plugin and the MWS will use the Blend Midi File operation to blend the data.

Bug Fixes
* Fixed code to stop program crash when using the PgUp function with certain multiple monitor
configurations.
>---<

Version 1.9 Enhancements And Bug Fixes
Enhancements
* Re-compiled the helpfile into the newer html help .chm format. This allows for better searching
and indexing as well as allows the helpfile to open correctly on Win 7, 8 and 10.
Bug Fixes
* Fixed code to stop program crash after exporting very large midi files.

*

Fixed code to allow very large midi files to blend properly without crashing.

>---<

Version 1.8 Enhancements And Bug Fixes
Enhancements
* Added a new menu item to the Track Properties popup menu called Pre-Allocate Record Buffer.
This option can be used to pre-allocate a large record buffer on a midi track to help overall system
performance and stability for live linked recordings with SAC. This eliminates the constant need to
increase record buffer sizes live during the record process as more space is needed. The
constant resizing can put a strain on the system as memory is constantly being allocated and reallocated. The number of max entries for the play buffer and record buffer are now displayed in
the lower right corner of the track label. The play buffer size is normally displayed and the record
buffer size displays when the track is armed for record.
Bug Fixes
* When SAWStudio was in Realtime Priority mode, certain system configurations could cause the
left or right click (as opposed to hold) feature for certain command functions to fail. This code
fixes that issue.
*

Fixed code to stop screen display corruption while dragging notes in Live Mode.

*

Fixed code to allow very large midi files to import properly without crashing.

*

Fixed code changes to help eliminate stuck notes which could happen under certain conditions
while recording.

*

Fixed code to properly trigger armed midi record from the SAWStudio Remote Record transport
when REC is pressed by itself without SRP.

>---<

Version 1.7 Enhancements And Bug Fixes
Enhancements
* Patch Changes in the Library View are now allowed during Rec/Rdy Mode, to facilitate the live
monitoring enhancements in the newer SAWStudio versions.
*

Step Draw can now be toggled on and off by pressing the D-Key.

*

Step Draw mode now creates undo files for each note added.

*

Step Draw mode now allows you to delete a note by Right-Clicking on the note, without the need
to exit Step Draw mode.

*

When adjusting the speed of the auto step advance in Step Rec mode, pressing Ctrl and clicking
the minus zone of the Step Rec switch sets the speed back to zero for single note auto advance
operation.

*

Importing and Blending Midi Files now auto scale and center the midi data on each track so all
midi notes are visible.

*

Blending Midi Files now responds to the starting cursor position and offsets data from there. If the
starting cursor position is past the end of the current data, then new tempo data is included in the
blend, otherwise tempo data is ignored.

*

Enhanced cursor lock and positioning between SAWStudio and MWS during Live Mode. Requires
SAWStudio 4.7 or higher or SAWStudioBasic 2.1 or higher.

*

Enhanced the Controller Display chase to operate in Live Mode.

*

A new option has been added to the popup Time Signature menu called Set New Time Signature
Entry Within Range. This option allows you to mark a range of measures ( do so with the grid ON)
and change the time signature for that range without disturbing the rest of the composition outside
the range. All measure numbers and tempo and time signature changes will remain the same for
following existing data. Midi data will be pushed or pulled into proper alignment. If the change
adds beats to the existing range area, the beats will be added at the end of the range leaving
original data intact. If the change deletes beats from the existing range area, the data will be
deleted from the end of the range. Most likely data transitions at the end of the range will have to
be re-composed, but all existing data outside the range will remain intact.

*

A new enhancement has been added that will automatically fix stuck notes that are missing NoteOff data. If you see a note stretching across a track with no off position, you can click on it, as if to
select it as the active note and it will sense and correct the missing Note-Off data by cutting the
note duration to the current Grid Note value.

*

A new option has been added to the Options Menu called Global Midi-In Chan Filter. This option
allows you to filter all incoming midi data down to a specific midi chan if desired. If set to a single
chan, all incoming data not on that chan will be discarded. This can be helpful with certain midi
keyboard controllers that send multi-chan midi data at the same time causing possible stuck notes
and missing Note-Off data. This setting can be saved in the preferences.

Bug Fixes
* Fixed the Major / Minor Scale color display option.
*

Fixed code that could damage time signature changes in measures that already contained tempo
changes.

*

Fixed code to trap mouse-click control adjustments from crashing looped playback under certain
conditions.

*

Fixed code to trap for crashes caused by dragging the mouse with the left button down into the

top client area of the MT while in Step Rec mode.
*

Fixed code to properly set note length when holding a note during the Auto Step Rec Advance
mode, when the advance speed is set to single note advance.

*

Fixed code to correct for different tick resolutions when blending midi files.

*

Fixed code to trap and correct for illegal tick resolutions when importing midi files.

*

Fixed code for more accurate midi file export and import of tempos.

*

Fixed code to trap and correct for illegal tempo and time signature entries when importing midi
files.

>---<

Version 1.6f Enhancements And Bug Fixes
Enhancements
* A new feature has been added to read an F-Key file from the command Line when the program
first starts. This requires SAWStudio or SAWStudioLite 4.0 or SAWStudioBasic 1.5 or higher.
See the SAWStudio helpfile for details.
*

Added the creation of a record Undo File when the engine is stopped if recorded data has been
added to the MultiTrack. If you never actually engage record or play no data once engaged, no
undo file will be created.

Bug Fixes
* Fixed code to stop unexpected erasure of midi data before the punch-in position when using the
Enter key to do the punch.
>---<

Version 1.6e Enhancements And Bug Fixes
Enhancements
*

Four new options have been added to the Modify Note Velocity menu called Note-On Velocity Randomize, Note-Off Velocity - Randomize, Note Velocity - Randomize Min Deviation, Note
Velocity - Randomize Max Deviation.
These options allow you to randomize note velocities.
They work on data within a marked range on the current track or selected tracks. The min and
max deviation values set the limits on the randomize algorithm, and relate to the minimum and
maximum adjustment values that can be applied to randomize the velocity values.

*

Four new options have been added to the Modify Note Quantize menu called Humanize [Entire
Note], Humanize [Start Time Only], Humanize Min Deviation, Humanize Max Deviation. These
options allow you to randomize note start tick positions. They work on data within a marked range

on the current track or selected tracks. The min and max deviation values set the limits on the
randomize algorithm, and relate to the minimum and maximum adjustment values that can be
applied to randomize the start tick position values.
Bug Fixes
* Code modifications done to enhance stability and eliminate corruption of screen displays with
multi-processors, multi-core processors and hyperthreading processors.
>---<

Version 1.6d Enhancements And Bug Fixes
Enhancements
* A new enhancement has been added to the Measure Map feature. You may now use the DownArrow-Key in Measure Map mode during live playback to actually tap time on the measure
downbeats and the Measure Map functions will automatically be written in. To do so, I
recommend using a zoom ratio on the MT that displays each measure boundary line
incrementally. Just start playback and tap the Down-Arrow Key at the measure downbeats. You
may then go back and manually adjust them to be accurate on the waveform transients that you
are syncing up to in the SAWStudio MT.
*

Starting playback when Live Mode is active will now auto toggle back into Live Mode when
playback is stopped. This feature requires SAWStudio version 4.0 or higher, or SAWStudioBasic
version 1.5 or higher.

*

Meter Displays are now bypassed for muted tracks.

*

In Select Mode, the Ctrl-A Select-All function now sets the first note as the Key Entry.

*

Three new Quantize options have been added to the Modify – Quantize Note menu which only
affect the Note Start Time and leave the Note End Time alone, shrinking or stretching the duration
as they quantize.
Clearing Tempo Entries is now sensitive to existing Time Signature changes at the same position
and will not disturb these entries.

*
*

Setting and clearing Time Signature Entry operations are now sensitive to existing Tempo
changes at the same position and will not disturb these entries. In addition, orphan and
incomplete measures created by the changes are automatically corrected by changing the orphan
beats before another existing Time Signature entry into single beat measures to keep measures
intact and properly bounded. This makes it easy to add or delete these extra measure/beats.

*

A new Tempo Entry option has been added to both the Tempo and Time Signature menus called
Remove Tempo / Time Signature Entries Within Range. This option deletes both Tempo and
Time Signature entries within the marked range and also corrects for orphan measures created
by the change.

*

The Insert and Delete Measures functions now pay attention to the current measure Time
Signature and also maintain measure boundary tempo and signature entries that are part of the
manipulated measures.

*

The controller display will now chase from cursor movements in the SAWStudio Multitrack as well
as from the MWS MultiTrack. This allows Auto-Rewind positioning after playback to update
controller display info as well.

Bug Fixes
* Fixed accuracy of Active Note Duration display.
*

Fixed code to properly re-adjust all midi note positions and durations after a Tick Resolution
change.

*

Adjusted the Note StartTime and Note Duration display format to allow display of tick resolution
numbers up to 4 digits. The Measure display was reduced from 5 to 4 digits to compensate.
When measure counts beyond 4 digits are needed, the measure and beat separator is reversed
and the measure count wraps around at each 10,000 value. For example, tempo display at
position 9999>01>0000 will display as shown and when it wraps around past measure 10,000 to
10,002 for example, the display will be shown as 0002<01>0000. This compromise was done to
salvage all existing SawStudio shades and the current pixel layout of the MultiTrack Top Client
area, as well as remain consistent with the SawStudio display format.

*

Fixed Step Record mode from advancing twice the grid note size when used without Live Mode
active.

*

Fixed disappearing Time Signature display entries at different zoom levels.

>---<

Version 1.6c Enhancements And Bug Fixes
Enhancements
Bug Fixes
* Fixed Measure Mapping from jumping back to beat 4 under certain adjustment conditions.
*

Adjusted code for the MT view to properly re-display memory image when resizing with the
Windows “Show Window Contents While Dragging” option ON.

>---<

Version 1.6b Enhancements And Bug Fixes
Enhancements
* Step Record Mode has been enhanced. Right-clicking to activate Auto Step mode now turns the

Step Record Lite yellow. If you click the minus zone to slow the auto advance down to a stop, the
cursor now advances automatically to the next grid position after every note is stepped in, as long
as the grid mode is active. If you play a chord, the advance will occur when the last note of the
chord group is released.
*

Track Labeling has been enhanced to function during playback and Live Mode.

Bug Fixes
* Fixed MT redraw problem when clicking on MT edge and then not resizing.
*

Fixed Step Entry and Step Draw modes to correctly enter notes after the end of pre-existing track
data. This could fail under certain conditions in 1.6a.

>---<

Version 1.6a Enhancements And Bug Fixes
Enhancements
Bug Fixes
* Fixed BuildMix operations to properly initialize the midi data.
>---<

Version 1.6 Enhancements And Bug Fixes
Enhancements
* MWS now passes back Virtual Midi Port names to display in the host VST Midi Port assignment
menu with SAWStudio Lite and Full version 3.9h and higher and SAWStudioBasic version 1.4h
and higher.
*

The Delete key is now active in Live Mode.

*

Adjusting note boundaries with the mouse is now active in Live Mode.

*

A new option has been added called Step Record Mode. There is a new switch on the MWS
MultiTrack next to the Grid switch. Left-Clicking on this switch turns it red and activates Step
Record Mode for the current HotTrack. The track must have a port and midi channel assignment
or this mode will not enter data. The cursor shape changes to denote that the mode is active. If
using VST synth modules, make sure to activate Live Mode so you can hear the audio output as
you move down the timeline. (You can Right-Click on the Play button). When Step Record Mode
is active, you can move the cursor freely with the mouse along the timeline, or use the Left and
Right Arrow keys. Turning Grid mode ON is a nice way to step precisely down the timeline
according to the Grid Note duration using the Arrow keys. You may now use the virtual Midi
Keyboard display to enter notes with the mouse, while you use the Arrow keys to step forward. If
you hold the note on and move the cursor, the note duration will be determined by where the
cursor is when you release the note. If you press and release a note without stepping the cursor,

the note duration will default to the Grid Note length, regardless of whether the Grid Mode is
active or not. You can enter chords, one note at a time without moving the cursor… then step
forward. You may also play notes on your midi keyboard controller and they will record. Another
exciting enhancement to this Step Mode is activated by Right-Clicking on the Step Record button,
once it is already activated. This starts an auto step feature which will slowly advance down the
timeline smoothly if the Grid Mode is Off or according to the Grid setting if On. You can Left-Click
in the Minus or Plus zones beside the switch to decrease or increase the auto step speed,
allowing you to playback the sequence at a crawling pace or at a speed near realtime. The
existing track data will be played across all tracks, except the current HotTrack that is recording
the data. You can also use the Select Track options to play only selected tracks, or select only the
HotTrack to mute the sound completely. The auto step allows you to step complex music
passages in at a very slow speed. If the Grid is On, the notes will auto-quantize as they are
stepped in. Right-Click the switch again, to toggle Off the auto step mode, or Left-Click the switch
to exit Step Record Mode while leaving the auto settings active for next time. While Step Record
Mode is active, you can still mark and delete entire sections, or select single notes and delete
them with the delete key. You can jump the cursor forward and backward by Left-Clicking in the
HotTrack. You must exit Step Record Mode to regain control of the rest of the MWS features and
normal playback operation.
*

A new option has been added called Step Draw Mode. There is a new switch on the MWS
MultiTrack next to the Step Record Mode switch. Left-Clicking on this switch turns it red and
activates Step Draw Mode for the current HotTrack. The cursor shape changes to denote that the
mode is active. If using VST synth modules, make sure to activate Live Mode so you can hear the
audio output as you move the mouse up and down in the HotTrack. (You can Right-Click on the
Play button). When Step Draw Mode is active, you can move the cursor freely with the mouse
along the timeline and up and down within the HotTrack. Turning Grid mode ON is a nice way to
step precisely down the timeline according to the Grid Note duration. The up and down movement
of the mouse will select the note, and display the note value in the Note Zone Readout display
and on the virtual Midi Keyboard display. The sideways movement of the mouse will set the note
start position and display its value in the Note Start Position Zone Readout display. Left-Clicking
will create a new note at the current position with a duration of the current Grid Note length. If you
hold the left mouse button down when you create the note, the cursor will automatically change to
the Extend Cursor shape and jump to the end of the note, allowing you to drag the end position
longer or shorter, thereby changing the duration. The duration value will be displayed in the Note
Duration Zone Readout as you drag. Releasing the mouse button will redraw the note at the new
duration. You must exit Step Draw Mode to regain control of the rest of the MWS features and
normal playback operation.

*

A new option has been added to the Options Menu called Midi Record Latency Adjust. This option
can be used to adjust plus or minus samples for midi keyboard latency. In some cases, usb
keyboards may actually cause recording positions to be early by x number of samples. Run some
tests by recording against a click track and then noting if the recording is averaging early or late
(obviously your timing ability comes into play here also). Use this option to force the recorded data
to be adjusted forward or backward when it is dropped to the MT.

*

A new option has been added to the Tempo Menu called Sweep To New Tempo Within Range.
This option allows you to mark a range and enter a new destination tempo and the tempo will be
smoothly swept from the current tempo to the new destination tempo across the marked range,

changing at every beat boundary.
Bug Fixes
* Fixed the Click Conductor code to restore the saved Midi Channel when there is no assigned
Instrument Device for the saved Port and Channel.
*

Fixed main MWS starting workspace from coming up as a black screen when saving F-Key
defaults from SAWStudio while the MWS is linked to SAWStudio F-Keys or Alt-F-Keys and not
visible as the default.

*

Fixed code to stop MWS from playing back data when the SAWStudio RecRdy and Record
modes are activated with live inputs and no SRP playback engaged.

*

Note Scrub mode now properly detects track mutes.

*

Note durations now properly display notes that cross beat boundaries in non-quarter note time
signatures.

*

The Insert Measures function no longer extends notes that overhang into the insert measure area.
The overhang remains the same into the new blank measures that are inserted.

>---<

Version 1.5c Enhancements And Bug Fixes
Enhancements
Bug Fixes
* Modified the Virtual Buffer data stream for VST synth plugins to fix compatibility issues with the
Native Instruments Kontakt product line. This fix should eliminate skipped and stuck note
problems when using multiple midi channels on Kontakt, Kompakt or other sampler plugins based
on the same or similar engine design.
*

Doubled the Midi-In buffer size to attempt to help with buffer overuns during recording that may be
the cause of stuck notes.

>---<

Version 1.5b Enhancements And Bug Fixes
Enhancements
Bug Fixes
* Fixed Tempo increments and decrements to maintain proper accuracy across all values. This
keeps grid snaps accurate down the timeline.

*

More work done on all floating point to integer conversion sections of the code for maintaining
precision throughout.

*

Fixed the Open Connected VST Synth option on the Track Properties menu to properly gray and
reflect a hardware or not assigned port.

>---<

Version 1.5a Enhancements And Bug Fixes
Enhancements
* Removed tick numbers from timeline ruler display to keep the display cleaner with varying tempos
visible at the same time.
*

Enhanced Click/Conductor Track to save settings for virtual ports that have no attached midi
devices.

Bug Fixes
* Fixed the Backspace individual note and selected notes snap-to-cursor function.
>---<

Version 1.5 Enhancements And Bug Fixes
Enhancements
* The original Select Mode Alt-Left-Click selection to position feature has been modified to be AltShift-Left-Click so there is no conflict with the new Alt-Left-Drag note start and duration
adjustments for all selected notes introduced in Version 1.4.
*

The Ctrl-C copy command has been enhanced to hold its marker data until another move or copy
command has been activated.

*

The Paste function has been enhanced to allow overwriting of underlying data. The normal default
operation merges new data from drags or Ctrl-C copies. Pressing the Alt-Key at the time of the
paste operation will clear underlying data at the destination before pasting the new data. When
using a mouse drag and move or copy command, start the drag operation first with the Shift or
Ctrl keys and then press the Alt-Key as you drop the data in its new location.

*

A new option has been added to the Record options menu (Right-Click any track Rec button),
called Midi Multi. This option will assign the current track and the next 15 tracks in record mode
and accept a multi-channel midi signal from one device port, and split the 16 midi channels to the
separate 16 record tracks. This can be useful when dumping from some hardware midi
sequencers in one pass, splitting the separate midi channel information into up to 16 separate
tracks for further editing in the MWS.

*

The Marked Area will now chase the HotTrack as it does in SAWStudio. The current operation will
focus on the data in the marked area on the current HotTrack, unless an All Tracks or a Selected
Tracks operation is activated. Special code for the use of the BackSpace key still allows you to
mark data on one track and change tracks for a destination snapped move or copy operation,
even though the marked area of the source has chased to the new destination track before
pressing the key and activating the command.

*

The Patch Library Bin data is now saved and restored with the Session EDL’s. If the EDL stored
Bin data was empty, then the current Bin data will not be disturbed, otherwise, the current Bin
data will be replaced by the data stored in the EDL Bin. Realize that the data stored is index
information relative to the current Patch Library. If the Patch Library is changed, some or all of this
stored data may no longer be valid.

*

A new option has been added to the Bin popup menu called Lock Bin. When this option is active,
the current Bin data will not be disturbed when opening a new EDL, even if the EDL has its own
stored Bin data.

*

The Data Knob has been enhanced to automatically update the current controller data entry once
the knob is moved. If a marked area of controller entries exists, the entire marked area is
updated.

*

The Pencil Draw mode has been enhanced with two new menu options called Pencil Drawing
Mode – Note ON Velocity and Pencil Drawing Mode – Note OFF Velocity. These modes allow a
fast and simple way to adjust note velocities in a graphic manner.

Bug Fixes
* Stopped Note-Off data from being sent on muted tracks to allow proper solo operation in
multitimbral mode with certain VST sampler plugIns that trigger special effects with note-off data.
*

Trapped Left-Click during scrub operation.

*

Fixed tempomap problem that could show up as a few samples difference on note start times that
would leave grid referenced copy and paste operations missing the first note.

*

The Alt-Shift and Alt-Ctrl Home and End Key Select Mode selection combos now work correctly.

*

Pasting marked ranges now correctly maintains track offset under all conditions, even with reordered tracks.

*

Trapped a possible crash that could occur when opening F-Key files that were created at a higher
screen resolution than the current resolution.

*

Adjusted code to fix the Windows ClipCursor function from failing on certain systems under
certain conditions.

>---<

Version 1.4a Enhancements And Bug Fixes
Enhancements
* Moved cursor, piano display and meter display to a separate thread to keep them from being
interrupted when accessing popup menues and commands during playback.
Bug Fixes
* Trapped main menues from activating during playback.
>---<

Version 1.4 Enhancements And Bug Fixes
Enhancements
* Pre-Release status has been removed. This version becomes the MWS official release version.
*

A new feature has been added for marking ranges. Pressing the Alt-End-Key in normal mode
marks an entire track no matter where the current cursor position is.

*

Range marking options are now active in Live Input Mode to facilitate VST Synth track editing.

*

The import Midi File function now also reads most Type 0 midi files. Different midi chan data will
be spread across the first 16 tracks in the MultiTrack, effectively separating out the midi chan data
into individual tracks. The tracks will be named with General Midi Prg names if prg data is found
for that particular midi chan and no name data was found.

*

A new option has been added to the File menu called Blend Midi File. This option allows you to
blend another Midi File into the current session. The current Hot Track acts as the starting track
for the new file. The tracks then increment down the MultiTrack. The tracks will follow in the virtual
MultiTrack track order as they are currently laid out. If any track has existing midi data, the next
empty track will be used. Tempo and Time Signature data will be ignored for the blended files and
they will be conformed to the current session tempomap.

*

Click/Conductor tracks now automatically use the auto scaling routines to focus and center click
data on the track.

*

Recording tracks now automatically use the auto scaling routines to focus and center newly
recorded data on the track.

*

Updating the patch database from ini files has been enhanced to flag missing ini files in a warning
message and cancel the update.

*

A new option has been added to the MWS File Menu called Open Midi WorkShop Session File.
This option allows you to access an .edl_mws file directly an open it into the current SAWStudio

session, thereby swapping existing midi data information or adding midi data information from
another session.
*

A new option has been added to the Track Properties popup menu called Disable Track. When
this option is active, the track display is Xd out and the midi notes are dimmed, and no midi data
is output at all from this track during playback. This differs from a muted track which still outputs
controller and midi note off data in case the track is unmuted during play. The disable track option
cannot be toggled while playback is active, so it does not have to chase controller data.

*

Select Mode has been enhanced to allow all selected note boundaries to be altered with the AltLeft-Mouse adjust feature. When either boundary of the Key-Entry is grabbed and adjusted, the
same boundary of all selected notes will be offset by the same amount. Any note that is adjusted
to a duration smaller than 1 tick will be set to a 1 tick duration.

*

The Pitch option has been activated on the Modify menu. There are three new active choices.
Transpose Up 1 Octave, Transpose Dn 1 Octave, and Transpose [Menu]. All options operate on a
selected range and will respond to multiple selected tracks.

*

The Note zone has been activated for changing the pitch of the current active note or all selected
notes in Select Mode. Left-Clicking in the Note zone (when there is a currently active note
displayed), changes the mouse cursor to a hand shape and snaps the mouse to the virtual
keyboard on the active note. While keeping the mouse button pressed, you are free to slide up
and down the keyboard to select a transposed note value. The notes will sound on the track’s
corresponding midi device. When the mouse is released, all selected notes will be transposed to
the new relative values and the mouse will return to the Note zone.

*

A new Minus/Plus zone has been added under the Note zone which allows simple mouse clicks to
decrement and increment the Note pitch value. The new note will sound on the track’s
corresponding midi device until you release the mouse button.

*

A new Minus/Plus zone has been added under the Note-On-Velocity zone which allows simple
mouse clicks to decrement and increment the Note-On- Velocity.

*

A new Minus/Plus zone has been added under the Note-Off-Velocity zone which allows simple
mouse clicks to decrement and increment the Note-Off- Velocity.

*

A new Minus/Plus zone has been added under the Note-Start-Time zone which allows simple
mouse clicks to decrement and increment the Note-Start-Time.

*

A new Minus/Plus zone has been added under the Note-Duration zone which allows simple
mouse clicks to decrement and increment the Note-Duration.

*

A new Minus/Plus zone has been added under the Ctrlr-Value zone which allows simple mouse
clicks to decrement and increment the Ctrlr-Value.

*

New Increment/Decrement zones have been added to the left side of each fader which allow
simple mouse clicks to increment and decrement the fader values.

*

Offset and Percentage menues have been modified for consistency throughout the interface.

*

Offset and Percentage Knob adjustments, using the Shift-Key and Ctrl-Key have been modified
for consitency throughout the interface.

*

A new feature has been added to Controller Display Mode. Pressing Ctrl-Tab will now jump you
forward to the next controller entry. Pressing Ctrl-Shift-Tab will jump you backward to the previous
controller entry.

*

Added MT mouse controlled vertical scrolling. Holding the Left-Mouse-Button down while pushing
against the bottom or top of the MT will scroll the MT vertically. This can be done during playback
also. This allows move/copy operations to tracks not visible on the MT at the start of the
move/copy procedure.

*

A new enhancement has been added for selecting tracks. You can now select All tracks by CtrlAlt-Left-Clicking on any track number. This will inverse all track number displays for use with
global editing operations.

*

Two new options have been added to the Modify menu called Insert Measures and Delete
Measures. These options will prompt for a measure count value to add or delete. The measure
under the MultiTrack current cursor position is used as the reference point for the operation. This
option works as a global operation across all tracks if no tracks are selected. In this case, tempo
and time signature entries are adjusted accordingly. If there are any selected tracks, only those
tracks will be affected and tempo and time signatures will not be altered.

*

The undo function has been enhanced to now take advantage of the new parse for File, Fx, Video
and Midi changes in the SAWStudio version 3.7 and skip these sections if possible.
SAWStudioBasic version 1.2 also supports these features. This enhances the recall undo
performance considerably when VST synths and many video file filter graphs are part of the
session.

*

Enhanced the F-Key restore routines to bypass certain Windows functions that were blocking
some of my High Level threads. This results in drastically better performance with less
interference at very low latency settings.

Bug Fixes
* Slight adjustment to the auto scaling code to better fit wide note ranges within a track display.
*

Trapped timeline clicking during playback to stop vertcal scrolling the MultiTrack.

*

Fixed PgUp max track sizing function to eliminate crash.

*

Adjustments made to help eliminate cursor drawing problems on certain systems under certain
conditions.

*

The virtual piano display now correctly turns all piano note displays off when the left mouse button
is released in Live Input Mode.

*

The Enter-Key will no longer stop playback when used to punch-in a record operation after
playback has been started.

*

Fixed a problem with the delete range function that could leave an endless stuck note when a
single note spans longer than the marked range.

>---<

Version 1.3 Enhancements And Bug Fixes
Enhancements
* More API Hook enhancements to the SAWStudio Host.
*

A new option has been added to the Options menu called Midi Short Msg Compatibility Mode.
This option displays a popup menu of all active midi ports. Selecting a port toggles the Short Msg
Compatibilty Mode on/off for that port. When the mode is active, the port will display a checkmark.
These settings save with the preferences. This mode is needed for certain midi drivers that will
not accept Midi Long messages for basic midi commands. The Midi Workshop uses Midi Long
messages for all of its midi communications by default for improved performance and timing
accuracy. Using the Midi Short Msg Mode increases the CPU load, as each midi command much
be processed separately through the Windows mechanism. Certain virtual port drivers like Giga
Studio may require this mode to be active in order to respond at all to the Midi WorkShop. The
internal MS Wave Synthesizer may also require this mode for program changes and other control
information to be processed correctly. Use this mode on a port ONLY if the port is not responding
correctly with this mode OFF.

*

A new option has been added to the MT Track Properties menu called Open Connected VST
Synth Module. This option is active when a VST Synth is connected on this track to a MWS
Virtual Port. By selecting this option, the program opens the correct VST Synth module window
directly, without having to go to SAWStudio's patch windows.

*

A new enhancement to start/stop Live Input Mode. Right-Clicking on the the Play button will now
start Live Input Mode if the engine is currently stopped, or stop the engine if it is currently in Live
Input Mode.

*

The virtual piano keyboard is now active during record. The keyboard records to the current
hottrack if the hottrack record is engaged.

*

Added a special routine to clear virtual midi port data just before the playback engine stops, to
help stuck note problems with VST synths.

*

Select Mode toggling is now active in Live Mode to facilitate editing on VST synth tracks.

*

Piano Keyboard display note chasing is now active in Live Mode.

*

A new option has been added to the Options Menu called Auto Solo/Audio Mute. When this
option is active, engaging any solo mode in the Midi WorkShop will automatically activate the
Mute Audio mode to force all SAWStudio audio tracks mute, so only the midi data is heard. The
Mute Audio button may be disengaged to hear the audio tracks along with the soloed midi tracks
at any time.

Bug Fixes
* Fixed selected track playback with VST synths. Now all selected tracks, even when re-ordered,
assigned to VST synths will play correctly.
*

Fixed marked range copies and moves for re-ordered selected tracks.

*

Fixed external keyboard midi thru code to allow changing hottracks when Live Input mode is
active for auditioning different patches on different tracks.

*

Fixed screen redraw problems for note and range drags during Live Input Mode.

>---<

Version 1.2 Enhancements And Bug Fixes
Enhancements
Bug Fixes
* Fixed a problem that was blocking program change commands from being sent to hardware ports
and virtual ports during Live Input Mode and playback mode when the track contained no midi
data.
*

Fixed Patch Library double-click patch change to VST Synths.

*

Mute Midi Mode no longer lights up all mute lights when view is closed and re-opened.

*

Mute settings are now correctly saved and restored even if the session is saved and opened with
the Mute Midi Mode active.

>---<

Version 1.1 Enhancements And Bug Fixes
Enhancements
* Two new options have been added to the Rec Port popup menu opened by Right-Clicking on a
Rec button. The Midi Thru option may be toggled to pass Midi Thru data for this record port and
the Midi Merge option may be toggled to merge the new recording with already existing track data.
These options will not be active until a port is selected. The Merge option remains active for this

port and follows it to whatever track is set to record from this same port. The menu stays active
after toggling either of these options, displaying the current status change. Click anywhere outside
the menu to close it when finished.
*

Live Input Mode may now be activated directly from the MWS MultiTrack window by pressing the
L-Key. The cursor will change shape giving visual feedback when Live Input Mode is active. VST
Synths may now be scrubbed while Live Input Mode is active. Right-Clicking or pressing the LKey or SpaceBar or Stop button will exit Live Input Mode. Editing features and certain positioning
features will be disabled in Live Input Mode.

*

Right-Clicking the Controller Display button will popup a new menu of options for drawing
controller data. Pencil Drawing Mode is a special mode allowing you to drag the mouse and draw
new controller entries. The cursor will change shape, displaying a crosshair and pencil icon. LeftDragging the mouse to the right will begin adding controller entries. The data value of the entries
depends on the relative vertical mouse position within the track height. Holding the Shift-Key will
force the value to a center default, useful for centering pans or setting pitch bends to their off
condition. The data value is constantly displayed in the Controller Value readout zone. You may
drag back to the left over newly created entries without releasing the mouse button and they will
be erased, allowing you to then redo your drawing curve. When the Left Mouse button is
released, the newly drawn entries will be added to the database, clearing and overwriting similar
controller entries within the drag range. You may exit Pencil Drawing Mode by pressing the
Escape-Key or by toggling Controller Display Mode Off, or by Right-Clicking the Display options
button and clicking the currently active Pencil Drawing Mode again.
Pencil Drawing Density: This option displays the current drawing density value and allows you to
change it. The drawing density is a tick value that becomes the minimum separation between
new controller entries as you slide the mouse in Pencil Drawing Mode.
Pencil Drawing Mode - Current Controller Type: This option activates Pencil Drawing Mode using
the currently displayed controller type. Certain types are not available for pencil drawing and this
option will be grayed and disabled for those types.
Pencil Drawing Mode - Volume: This option activates Pencil Drawing Mode and automatically
forces the Controller Filter to Volume if needed.
Pencil Drawing Mode - Pan: This option activates Pencil Drawing Mode and automatically forces
the Controller Filter to Pan if needed.
Pencil Drawing Mode - Pitch Bend: This option activates Pencil Drawing Mode and automatically
forces the Controller Filter to Pitch Bend if needed.
Pencil Drawing Mode - Prg Change: This option activates Pencil Drawing Mode and automatically
forces the Controller Filter to Prg Change if needed.

Bug Fixes
* Fixed a VST Synth looping problem that could occur when there was no active Midi data on a
VST Synth Track and a Midi graphic keyboard or controller thru event was triggered.

*

The session active flag is now set correctly whenever a port or chan is set so that edl session
saves will include the Midi WorkShop as active.

*

The Update Patch .ini routine has been fixed to open very large patch .ini file sizes.

*

The EDL session dirty flag is now set correctly after a record operation.

*

Stopped certain editing menus that should be disabled during playback from activating.

>---<

Version 1.0 Enhancements And Bug Fixes
Enhancements
* This is the first release of the Add-on.
Bug Fixes
>---<

